
A.	 Fill in the blanks.

	 1.	 A computer is a ____________which helps us to do several tasks.

	 2.	 ____________ are those components of a computer that we can see and touch.

	 3.	 A monitor looks like a ___________screen and displays everything we do on a computer.

	 4.	 Central Processing Unit (CPU) is the _________ of a computer.

	 5.	 ____________ (MU) can store data and instructions to be processed in the CPU.

B.	 State whether the following statements are True or False. Correct the false statements.

	 1.	 Liquid Cathode Display (LCD) Monitor is very big in size and is also very heavy.

	 2.	 Memory Unit controls and transfers the information from one part of the CPU to another.

	 3.	 A CPU is the most common hardware device which is used to enter data into a computer.

	 4.	 There are three types of software: working software, system software and application 
software.

	 5.	 A computer accepts, examines and calculates the result. This is called processing.

C.	 Choose the correct answer.
	 1.	 Which monitor displays clearer pictures than LCD and CRT monitors?

			   (a)	 Light Emitting Diode Monitor

			   (b)	 Liquid Emitting Diode Monitor

			   (c)	 Light Emitting Decoding Monitor

			   (d)	 Liquid Emitting Decoding Monitor
	 2.	 Which of the following is not a part of the CPU?

			   (a)	 Memory Unit (MU)

			   (b)	 Control Unit (CU) 

			   (c)	 Arithmetic and Logical Unit (ALU)

			   (d)	 Home Unit
	 3.	 ________________________ performs arithmetical calculations like addition, subtraction, 

multiplication and division.
			   (a)	 Arithmetic and Logical Unit
			   (b)	 Memory Unit
			   (c)	 Control Unit
			   (d)	 Monitor
	 4.	 These keys are used to type letters and numbers. Name the keys.
			   (a)	 Special Keys
			   (b)	 Alphanumeric Keys
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			   (c)	 Function Keys
			   (d)	 Navigation Keys
	 5.	 When we press and release the left mouse button, it is called a _____________.
			   (a)	 double-click
			   (b)	 single-click
			   (c)	 right-click
			   (d)	 double right-click

D.	 Match the columns. 
			   Column A 		  Column B
	 1.	 Backspace key	 (a)	 Used to type letters in upper case
	 2.	 Delete key	 (b)	 Moves the cursor ahead by one space
	 3.	 Enter key	 (c)	 Erases text placed before the cursor
	 4.	 Space bar key	 (d)	 Also called the Return key
	 5.	 Caps Lock key	 (e)	 Erases text placed after the cursor

E.	 Answer the following questions.
	 1.	 Write a short note on Navigation keys.
	 2.	 Name and explain the different types of Special keys on the keyboard.
	 3.	 Explain the IPO cycle with example. 
	 4.	 Explain three more hardware devices other than the main components of a computer.
	 5.	 Define software. Explain the two types of software.



Answers to Worksheet

A.	 1.	 smart machine			   2.	 Hardware	 3.	 Television
	 4.	 Brain			   5.	 Memory Unit
B.	 1.	 Liquid Cathode (Crystal) Display (LCD) Monitor is not very big in size and is also not very heavy.
	 2.	 Memory (Control) Unit controls and transfers the information from one part of the CPU to 

another.
	 3.	 A CPU (keyboard) is the most common hardware device which is used to enter data into a 

computer.
	 4.	 There are three (two) types of software: working software, system software and application 

software.
	 5.	 True
C.	 1.	 (a) 	 2.	 (d) 	 3.	 (a)	 4.	 (b) 	 5.	 (b)
D.	 1.	 (c) 	 2.	 (e) 	 3.	 (d)	 4.	 (b) 	 5.	 (a)
E.	 1.	 Navigation Keys: These keys are used to move the cursor around in a document to see or make 

changes in the text. Page Up, Page Down, Home, End and arrow keys are navigation keys. 
The arrow keys are used to move the cursor in different directions. They are also called cursor 
control keys.

	 2.	 Special Keys: These keys are used to perform a specific task. The functions of some special keys 
are discussed here.
•	 Backspace key erases text placed before the cursor and the text selected by us.
•	 Delete key erases text placed after the cursor and the text selected by us.
•	 Enter key is used to type from a new line or to send the cursor to the next line. It is also 

called the Return key.
•	 Space bar key moves the cursor ahead by one space. It gives space between two letters, 

numbers or words. It is the longest key on the keyboard.
•	 Shift keys are used in combination with other keys for different purposes. For example, 

Shift key is pressed with any letter key to type the letter in upper case.
•	 Caps Lock key is used to type letters in upper case (capital letter).
•	 Control (Ctrl) keys are pressed with other keys to perform special tasks.
•	 Symbol keys are used to add punctuation marks and other symbols while typing.

	 3.	 Data and instructions are entered in an IPO cycle. They are processed and stored. Then the 
result is obtained.

		  Input: Instructions and commands given to a computer are called inputs or data.
		  Processing: A computer accepts, examines and calculates the result. This is called processing.
		  Output: The result given by a computer after processing is called information or output.
		  Let’s understand the IPO cycle with the help of the following example.
		  Making a drawing involves the following.

•	 We need a pencil, eraser, paper and crayons to draw a picture. These are the inputs.



•	 Using the pencil, eraser, paper and crayons to make a drawing is processing.
•	 The completed drawing is the output.

	 4.	 Three other hardware devices are as follows.
•	 Printer: We use a printer to take printouts of our work on paper. Hard copy is the output 

printed on paper.
•	 Plotter: It is a type of printer which takes commands from a computer to draw line drawings 

which also involves text. The output is printed by moving coloured pens across the paper 
to draw continuous point-to-point lines.

•	 Speakers: We use speakers to listen to music and sounds on a computer.
	 5.	 Software is a set of instructions that perform a specific task on a computer system. There are 

two types of software: system software and application software.
•	 System Software: The main software which allows the computer to run and perform all 

its essential tasks is called the system software. A computer cannot operate on its own 
without a system software. Operating systems like Windows 7, Windows 8 and Windows 10 
are examples of system software.

•	 Application Software: The software that allows us to perform specific tasks or applications 
on a computer is called the application software. Word processing software (Word 2016), 
spreadsheet software (Excel 2016), presentation software (PowerPoint 2016) and Paint are 
some examples of application software.



Chapter 2: GUI Operating System: An Introduction

A.	 Fill in the blanks.

	 1.	 Microsoft Windows, Linux and Mac are the most commonly used_____________.

	 2.	 There are two main types of user interface: __________________and________________.

	 3.	 The latest version of Windows is_________________.

	 4.	 When we switch on a system, the main screen of Windows appears. It is called___________.

	 5.	 When we right-click on the blank area of a desktop. A list of options called the _____________ 
appears.

B.	 State whether the following statements are True or False. Correct the false statements.

	 1.	 In Command Line Interface, the user interacts with the computer through graphics or 
pictures.

	 2.	 The taskbar is the main screen of Windows 10. 

	 3.	 The small graphics or pictures on the desktop are called icons.

	 4.	 The colour of the selected icon does not change to its original colour when it is deselected.

	 5.	 The long horizontal bar present at the bottom of the desktop is called desktop bar.

C.	 Choose the correct answer.
	 1.	 Microsoft Windows, Linux and Mac are examples of ______________.

			   (a)	 application software

			   (b)	 system software

			   (c)	 operating system 

			   (d)	 computer system
	 2.	 ______________ is the way by which a user interacts with a computer.

			   (a)	 User interface

			   (b)	 Speaker

			   (c)	 Microphone

			   (d)	 Keyboard
	 3.	 _________________ is the most common operating system being used worldwide.

			   (a)	 Microsoft Word

			   (b)	 Microsoft PowerPoint

			   (c)	 Microsoft Access

		   	 (d)	 Microsoft Windows
	 4.	 There are icons and a ___________present on the desktop.

			   (a)	 Deskbar

			   (b)	 Taskbar

			   (c)	 Keypad

			   (d)	 Mouse



	 5.	 On _______________ the icon, it gets opened in a new window.
			   (a)	 double-clicking
			   (b)	 single-clicking
			   (c)	 right-clicking
			   (d)	 left-clicking

D.	 Match the columns. 
			   Column A 		  Column B
	 1.	 Taskbar 	 (a)	 Shows programs which are being worked upon
	 2.	 Start button 	 (b)	 Right side of Taskbar
	 3.	 Notification area	 (c)	 The most important button on Taskbar
	 4.	 Middle section 	 (d)	 Image that fills the screen when the computer is 

left idle
	 5.	 Screen Saver 	 (e)	 Long horizontal bar at the bottom of desktop

E.	 Answer the following questions.
	 1.	 What is the start button and what does it do? 
	 2.	 Write a short note on live tiles in Windows 10.
	 3.	 What is the normal mode in Windows?
	 4.	 Explain the safe mode in Windows.
	 5.	 What is a screen saver? How can it be removed?



Answers to Worksheet

A.	 1.	 operating systems		 2.	 Command Line Interface (CLI); Graphical User Interface (GUI)
	 3.	 Windows 10			   4.	 Desktop	 5.	 shortcut menu
B.	 1.	 In Command Line Interface (Graphical User Interface), the user interacts with the computer 

through graphics or pictures.
	 2.	 The taskbar (desktop) is the main screen of Windows 10.
	 3.	 True
	 4.	 The colour of the selected icon does not change (changes) to its original colour when it is 

deselected.
	 5.	 The long horizontal bar present at the bottom of the desktop is called desktop bar (taskbar).
C.	 1.	 (c)	 2.	 (a)	 3.	 (d)	 4.	 (b)	 5.	 (a)
D.	 1.	 (e)	 2.	 (c)	 3.	 (b)	 4.	 (a)	 5.	 (d)
E.	 1.	 Start button is the most important on the Taskbar. A list of options appears on clicking the Start 

button. It helps the user to perform various tasks such as opening a program or document that 
needs to be worked upon, searching the required files and folders and turning the computer 
off. 

	 2.	 Windows 10 comes with a set of live tiles present in the right pane of the Start menu. These 
tiles provide latest updates and information about several things such as various happenings 
around the world, weather forecasts and reports, and notifications about the mails received. 
This does not require the opening of apps. These tiles can be rearranged, resized and moved 
as desired.

	 3.	 Normal mode is the default working mode of Windows. All the drivers in Normal mode are 
loaded by default in a computer during start up to ensure its proper functioning. There are no 
restrictions of graphics driver, sound driver, network driver or server driver. Windows appears 
with all colours and it has a high resolution in the Normal mode. There is no display of any 
label in Normal mode.

	 4.	 Safe mode is the diagnostic mode of Windows that allows users to detect, repair and 
troubleshoot issues in order to make the computer work properly. Safe mode does not allow 
loading of some drivers. It will only allow files and driver which are required for primary 
functioning of the computer. There are limited colours in Windows and the resolution is also 
low in the Safe mode. ‘Safe Mode’ is displayed on all the corners of the desktop screen in Safe 
mode.

	 5.	 Screen saver is an image that fills the screen whenever the computer is left idle for some time. 
The original screen can be restored by moving the mouse or pressing any key.



Chapter 3: Word 2016

A.	 Fill in the blanks.
	 1.	 The cursor automatically shifts to the next line while typing. This feature of Word is called 

______________.
	 2.	 _______________ is the larger window which helps the user to interact with Word program.
	 3.	 _________________ is the window inside the Application window where the user can type, 

edit and format the text.
	 4.	 Word 2016 provides options to make changes in the _______________ we work on.
	 5.	 A new document on your screen appears with a temporary name _______________.

B.	 State whether the following statements are True or False. Correct the false statements.
	 1.	 You cannot move the selected text from its original location to a new one in Word.
	 2.	 The Cut button appears on the ‘Paragraph’ group in the ‘Insert’ tab.
	 3.	 You can also press Ctrl + x for the Paste option. 
	 4.	 The Copy button appears on the ‘Clipboard’ group on the ‘Reference’ tab. 
	 5.	 Save button appears on the ‘Quick Access toolbar’.

C.	 Choose the correct answer.
	 1.	 ____________ text means to duplicate the text at a new location.
			   (a)	 Moving
			   (b)	 Copying
			   (c)	 Pasting
			   (d)	 Dragging
	 2.	 What is located at the top of the screen and displays the name of the document followed by 

the application name ‘Word’.
			   (a)	 Scroll Bar
			   (b)	 Menu Bar
			   (c)	 Title Bar
			   (d)	 Home Bar
	 3.	 It is placed at the upper-left corner in the Title Bar. What is it called?
			   (a)	 View Tab
			   (b)	 Home Tab
			   (c)	 Review Tab
			   (d)	 File Tab
	 4.	 Which of the following is not a Tab?
			   (a)	 Moving
			   (b)	 Layout
			   (c)	 Insert
			   (d)	 Design



	 5.	 It is located at the bottom of the screen and displays information like number of pages, 
number of words, language and zoom slider. What is it called?

			   (a)	 Status Bar
			   (b)	 Ribbon 
			   (c)	 Title Bar
			   (d)	 Rulers

D.	 Match the columns.
			   Column A 		  Column B
	 1.	 Open an existing Word document 	 (a)	 Ctrl + S
	 2.	 Save a document 	 (b)	 Alt + F4
	 3.	 Open the Save dialog box 	 (c)	 Ctrl + O
	 4.	 Exit Word 2016 	 (d)	 Ctrl + W
	 5.	 Close a document in Word	 (e)	 F12 key

E.	 Answer the following questions.
	 1.	 Write the steps to close a Word document and exit Word 2016. 
	 2.	 Write the features of Word 2016.
	 3.	 Write the steps to cut the text from one location and paste it at another location in Word.
	 4.	 Name the components of the document window in Word.
	 5.	 Write the steps to print a Word document.



Answers to Worksheet

A.	 1.	 WordWrap	 2.	 Application window	 3.	 Document window
	 4.	 Document	 5.	 Document1
B.	 1.	 You cannot (can) move the selected text from its original location to a new one in Word.
	 2.	 The Cut button appears on the ‘Paragraph’ (Clipboard) group in the ‘Insert’ (Home) tab.
	 3.	 You can also press Ctrl + X (CTRL + V) for the Paste option.
	 4.	 The Copy button appears on the ‘Clipboard’ group on the ‘Reference’ (Home) tab. 
	 5.	 True
C.	 1.	 (b) 	 2.	 (c)	 3.	 (d)	 4.	 (a)	 5.	 (a)
D.	 1.	 (c) 	 2.	 (a)	 3.	 (e)	 4.	 (d)	 5.	 (b)
E.	 1.	 Follow these steps to close the document.
		  1.	 Click on the File tab and select the Close option. You can also press the shortcut key  

Ctrl + W.
		  2.	 You will observe that Word 2016 will prompt you to save the changes if they are not saved 

before closing the document.
		  Follow these steps to exit Word 2016 after completing your work.
		  1.	 Click on Close button on the ‘Title Bar’ to exit the Word application.
		  2.	 You can also exit the application by pressing Alt + F4.
	 2.	 The features of Word 2016 are as follows.

•	 Type text and make changes in the existing text.
•	 Give a presentable look to the typed text by using different colours and effects.
•	 Add images with the text.
•	 Correct spelling and grammatical errors.
•	 Align text within margins.
•	 Offer a variety of font styles and font sizes.
•	 See the preview of the typed text. 
•	 Find and replace the text.
•	 Save the text to be used later.
•	 Print the text documents.

	 3.	 Follow these steps to cut the selected text from its original location to a new one.
		  1.	 Select the text to be moved.
		  2.	 Click on the Cut button on the ‘Clipboard’ group in the ‘Home’ tab. You can also press 

Control key with letter key X (Ctrl + X).
		  3.	 The text will disappear from the original location.
		  4.	 Now position the cursor at the location in the document where you want the text to be 

moved.
		  5.	 Click on the Paste button on the ‘Clipboard’. You can also press Ctrl + V.



		  6.	 The selected text will appear at the new location.
	 4.	 The components of a document window are as follows.

•	 Title Bar
•	 File Tab
•	 Quick Access Toolbar
•	 Tabs
•	 Ribbon
•	 Rulers
•	 Text Area
•	 Status Bar
•	 Scroll Bars

	 5.	 Follow these steps to print a document.
		  1.	 Click on the File tab and select the Print option from the menu.
		  2.	 The preview of the document will appear on right side of the screen.
		  3.	 Click on the Print button.
		  4.	 You will get the hard copy of the document.



Chapter 4: The Internet: An Introduction

A.	 Fill in the blanks.
	 1.	 A group of computers linked together through physical wiring or a wireless system is called 

a_________________.
	 2.	 A well-organised and managed network of millions of computers connected all over the 

world is called_________________.
	 3.	 There are various ____________ available for searching information. 
	 4.	 Students can access the required study material in the form of_______________, tutorials 

and _________________on the Internet.
	 5.	 The unwanted advertisement e-mails received by the user are called___________.

B.	 State whether the following statements are True or False. Correct the false statements.
	 1.	 Internet is also called the global network of computers.
	 2.	 The computers connected over the Internet cannot share and exchange all kinds of 

information.
	 3.	 The users can find very less information on the Internet.
	 4.	 We can send and receive information anytime and anywhere with the help of e-commerce.
	 5.	 We cannot book airline/railway/bus or movie tickets using the Internet.

C.	 Choose the correct answer.
	 1.	 What deals with the buying and selling of goods and services over the Internet?
			   (a)	 E-commerce
			   (b)	 E-mail
			   (c)	 E-learning
			   (d)	 E-banking
	 2.	 ____________ allows the users to do banking transactions without going to a bank.
			   (a)	 E-commerce
			   (b)	 E-mail
			   (c)	 E-learning
			   (d)	 E-banking
	 3.	 Users can have a live interaction visually from any part of the world using___________________.
			   (a)	 E-mail
			   (b)	 Chat
			   (c)	 Video conferencing
			   (d)	 E-banking
	 4.	 What is a collection of web pages containing related information called?
			   (a)	 Webpage
			   (b)	 Website
			   (c)	 Web address
			   (d)	 Search engine



	 5.	 The main or first page of a particular website is called the _______________.
			   (a)	 website
			   (b)	 home page
			   (c)	 web address
			   (d)	 web page 

D.	 Match the columns.
			   Column A 		  Column B
	 1.	 World Wide Web 	 (a)	 Internet Explorer, Mozilla Firefox, Opera, Google Chrome
	 2.	 Search engine 	 (b)	 Collection of web pages
	 3.	 Web browser	 (c)	 Address of a website
	 4.	 Website 	 (d)	 Google and Yahoo
	 5.	 URL 		 (e)	 Collection of various websites

E.	 Answer the following questions.
	 1.	 Write the steps to open the web page ‘www.timesofindia.indiatimes.com’.
	 2.	 What practises should be followed to keep the computer system protected?
	 3.	 What practises should be followed to stay safe while working online?	
	 4.	 What are netiquette? Mention six netiquette that you need to follow.
	 5.	 What are the disadvantages of Internet?



Answers to Worksheet

A.	 1.	 computer network		 2.	 Internet	 3.	 websites
	 4.	 worksheets; video lessons	 5.	 spam
B.	 1.	 True
	 2.	 The computers connected over the Internet cannot (can) share and exchange all kinds of 

information.
	 3.	 The users can find very less (every kind of ) information on the Internet.
	 4.	 We can send and receive information anytime and anywhere with the help of e-commerce 

(e-mail).
	 5.	 We cannot (can) book airline/railway/bus or movie tickets using the Internet.
C.	 1.	 (a)	 2.	 (d)	 3.	 (c) 	 4.	 (b)	 5.	 (b)
D.	 1.	 (e)	 2.	 (d)	 3.	 (a) 	 4.	 (b)	 5.	 (c)
E.	 1.	 Follow these steps to visit the given web page.
		  1.	 Place the cursor at the ‘Address Bar’.
		  2.	 Type the address or URL of the web page or website to be visited ‘www.timesofindia.

indiatimes.com’.
		  3.	 Press the Enter key. This will take you to The Times of India website. 
	 2.	 Following practises should be followed to keep the computer system protected.

•	 Using Antivirus: A software that finds and destroys computer viruses is called an antivirus. 
It protects the computer system against the attack of viruses. Some examples of commonly 
used antivirus are Norton, McAfee, Quick Heal, AVG and Symantec.

•	 Keeping Data Backup: The users should always keep the backup of data on a secondary 
storage device. This helps to keep the data safe for later use.

•	 Staying Careful while Searching Online: There is a lot of information available on the 
Internet nowadays. However, it is important to stay careful while surfing and selecting the 
information. You must always take the help from your elders.

	 3.	 While working online, keep these things in mind to stay safe.
•	 Selecting Strong Passwords: A series of letters, numbers or special symbols that you must 

type into a computer or computer system in order to be able to use it is called a password. 
One should always select a strong and unique password which can be a combination of 
letters, numbers and special symbols. 

•	 Being Careful while Making Friends Online: One should be very careful about talking 
to people online and selecting them as friends. People may be fake and pretend to be 
someone else.

•	 Not Giving Personal Details to Strangers: It is a strict no to give the personal details to 
strangers as they can be misused by people.

•	 Staying Careful while Shopping Online: You must be careful while sharing your credit or 
debit card details. Also, you should check all the details of the website from where you buy 
things.



	 4.	 There is a set of rules that the user should follow while using the Internet to respect the privacy 
of other people. These rules are called netiquette.

		  Following are a few netiquette.
•	 Write clearly so that other users are able to understand what you are trying to convey.
•	 Be very careful about what you write. Your posts are public and can be viewed by anyone.
•	 Avoid using all caps while writing. It is considered rude. It makes the others think that you 

are shouting at them.
•	 Use appropriate language while writing. Avoid spelling and grammatical errors.
•	 Make sure that the information provided by you is true in every aspect. However, do not 

share your personal information like your address and telephone number.
•	 Always be yourself while doing any kind of online activity. Do not fake in anyway.
•	 Avoid using fake e-mail IDs.

	 5.	 Following are the disadvantages of Internet
•	 Loss of Information: The information that we share on the Internet can be stolen by 

someone with bad intentions. Therefore, one should not share personal information like 
bank details, passwords, and details of credit and debit cards.

•	 Spread of False Information: Sometimes, the information present on the Internet may not 
be true. But it spreads instantly, thus causing problems and misunderstandings.

•	 Virus Threat: Computers connected to the Internet can be attached by virus. This can delete 
important files from the system.

•	 Spam: The unwanted advertisement e-mails received by the user are called spam. These 
slow down the system and sometimes, they may contain virus.


